Microsoft OneNote Basics

What is OneNote?

An electronic version of a 3-ring binder.

First introduced with Office 2003.
Latest client version is 2016.

OneNote for Windows 10 comes preinstalled with Windows 10.

Download OneNote for free at: https://www.onenote.com/download

-

There are Two OneNote Apps: Client and Browser

To launch OneNote from your computer, tap the Windows key
and type "OneNote” in the search box.

e Choose OneNote app to launch the OneNote 2016 client.
e Choose OneNote for Windows 10 the browser-based version of OneNote.

Both have slightly different layouts so it's
really a matter of preference which one you
. OneNote
choose to use. Microsoft also makes the u
OneNote Class Notebook, a browser-
based version which can be used with
Blackboard. You can install an add-in Manage
program to the OneNote 2016 client to

include Class Notebook capabilities. You OneNote for Windows 10
can also download a mobile version.

Change the Default App for File
Types w OneNote

1. Tap the windows key and type
File type and protocol associations

\\Appsll
2. Select Apps & Features Name Default app
3. Choose Default Apps
. .one OneNote
4. Click Set Defaults by App Microsoft OneNote Section u
5. Look for OneNote. You should see
. . .onepkg OneNote
two ap.ps listed. If you click the tOp Microsoft OneNote Single File Package u
app (client) a manage button will
appear. -onetoc OneNote
Microsoft OneNote 2003 Table Of Cont
6. The Manage button tells you which onetoc? OneNote
app“cation will launch depending Microsoft OneNote Table Of Contents
on file type clicked:
ONENOTE OneNote
URL:OneNote Protocol u
ONENOTEDESKTOP OneNote
URL:OneNote Protocol
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https://www.onenote.com/download

Navigate the OneNote 2016 Environment

OneNo
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ToDo Find Outicok  Email | Meeting
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Remember everything

» Add Tags to any notes
» Make checklists and to-do lists
» Create your own custom tags

v/

To Do
Tag

HOME —

Collaborate with others

Heisler, Patti
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“| OneNote Basics

OneNote: one place for all of your n

» Keep your notebooks on OneDrive

» Share with friends and family

e Anvong can adit in o hroncar

3 Key Areas to Know

1. Left panel lists all your notebooks
2. Tabs across the top: sections (divider tabs) within the selected notebook
3. Right panel: pages within the selected section

When you first start using OneNote, a default notebook with tips and tricks is provided for you.

Navigate the OneNote for Windows 10 App

neNote for Windows 10

6
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Create a New Notebook

OneNote notebooks can be stored on your computer, OneDrive, a Teams site, or an Office 365 Group site. To
create a class notebook, you create the notebook in the Learning Management system such as Blackboard. A
class notebook is stored in OneDrive by default because it is automatically shared with students.

In OneNote, choose File, New

Select one of the following locations for your notebook (see N ew N O‘te book
right)
@ Recent

3. Give your notebook a name
Notebooks stored on a hard drive or network drive appear as a folder. ST o S 22

patti.heisler@ndus.edu

For example:
Q Sites - North Dakota Univ...
M}r MNotebook patti.heisler@ndus.edu
Inside the folder you'll see files that represent each section of the :_Q This PC
notebook. A recycle bin icon may also appear. You can double-click e
any section to open the notebook: @ Add a Place
[:| Computer Science.one [ Browse

Data Science.one

N

0| Introduction.one

0 IT Infrastructure.one

[_' Open Notebook.onetoc?2
0| Productivity.one

In OneDrive, Teams, and 0365 Groups the link is stored on the web and it will also appear in a folder as a
shortcut. Double-click the shortcut to open the notebook:

ﬁ' Principles of Marketing

Opening Notebooks - If you're using the OneNote 2016 client, you can simply open that and all your notebooks
will be open and ready for you. Notebooks you no longer use can be closed using

the File, Close command. EXpOI'J[

Saving Your Work - OneNote does not have a File, Save or Save as option. Your

work is automatically saved. 1. Export Current:
Export - You can export pages, sections or even your entire notebook as a PDF [m,
. . . Page
file by choosing File, Export. ]
Bold — Notebooks, sections, and pages with bold lettering indicate those pages F[E'] SeEiEm
have not read. The letters will become unbolded after clicking on it or you can
right click to mark as read. FI[E'] Notebook
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Common Uses of OneNote

Shared notebooks can be more effective in organizing meetings:

Mectings  NDUS Training ~ Hoonuit  Blackboard
Agenda 9/15/20

Wednesday, August 12, 2020

Ally Lockdown Browser

Pull meeting

9:18 PM . .
information

from Outlook

Meeting Subject: AST team meeting - 9/15/2020
Meeting Date: 9/15/2020 8:30 AM
Location: Microsoft Teams Meeting
Link to Outlook Item: click here
Invitation Message (Expand)
Participants (Cdlapse)

'EI Wald, Randy (Meeting Organizer)

E Heisler, Patti (Accepted in Outlook)
'EI Thompson, Cheryl (Accepted in Outlook)
Notes
Who What
Cheryl Update on Labster Panel
Other get togethers:
. Assessmentsmecmring
* Yula Advanced - follow up from Randy's request last week on
Training allowed
All Tara Thompson - Blackboard -- Email on checking in

I hope all is well with you and yours. It's been a while since we last

checked in on your licensed materials use so | thought I'd reach out
to see how things were coming along. Any new or exciting projects
in the works? How are the materials working out for you? Anything
we can help with?

Turnitin VoiceThread Labster User Services Fall 2020

See who
makes edits

Action/Follow Up

Will be held Oct 7 - have 2 faculty lined up.
Best Practices sheet - suggested by Patti

Cheryl - possible Tips & Tricks sharing session, 30 min.

Patti: Responds to Tara if we have a request e

They are just checking in.

You can send email messages to OneNote to stay better organized:

Project Info HowTo | Goalsand Aligns | Documentation
Blackboard Update
Tuesday, November 22, 2016 4:14 PM

Subject  Blackboard Update
From
To
Attachments
are included

Cec
Sent
ﬁgachme mf.

Blackboard

Implement
Colleagues:

It has been a few weeks since | last updated this group on our progress with Blackboard. Attached is the
documentation of what we have learned over the past weeks and our recommendations for moving forward. If

you have questions or comments, please let me know.

|
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Find information faster across all your notebooks:

Finished: All Notebooks (change)

Rec

O
O
O
W]

ent picks

Tickets Team Dynamix Help
Blackboard Ticket Routing ...
Identified Defects

Team Dynamix Ticketing Se...

In title: tickets (23)

¢ JODDODODDODODODoDoDoDoDOoo

Ticket Help Notes

Ticket Categories

FW: Concerns with Ticket #...
Autoplay Ticket #165186505
Ticket Triage

Ticketing Systems
Troubleshooting/Tickets

Tickets Desktop Support Te...
Submitting Tickets For Desk...

SNOW Tickets

UND BB Tickets

UND BB Tickets

Bb Learn Ticket Summary
BTB Tickets

SNOW Tickets

Help Ticket Templates
SNOW TICKET TEMPLATE
How to Reassian a Ticket

Pin Search Results (alt+Q)

fickets

*

Find on page (Ctrl+F)

(ALTResources » Procedural)
(NDUS CTS BB SaaS Noteb...
(Yula » Troubleshooting)

(Archive - OneDrive » Black...

(NDUS CTS BB SaaS MNoteb...
(NDUS CTS BE SaaS MNoteb...
(NDUS CTS BB SaaS MNoteb...
(Yula » Troubleshooting)
(NDUS CTS CPR Notebook ...
(NDUS CTS CPR Notebook ...
(Yula » Troubleshooting)
(ALTResources » New Hire)
(NDUS CTS Academic Com...
(Research » SNOW)

(NDUS CTS BB SaaS MNoteb...
(Archive - OneDrive » Black..
(NDUS CTS BB SaaS Noteb...
(NDUS CTS BB SaaS Noteb...
(NDUS CTS BE SaaS Noteb...
(Archive - OneDrive » Black..
(Archive - OneDrive = Black..
(NDUS CTS Academic Com...

-

-

Use the Quick Notes feature (Sticky note) to take notes while attending a webinar:

B Blackt

vard Collaborate Ulra -0 3 [l Office

C @ usbbcollab.com

How to remove a user from a session:

Open participant panel

Right click on

Cheryl Thompson

Randy Wald

of your attendees have exited.

: N s ojvients ik to simply

3 Artendees

Moderator (1)

@ Parti Heisler

Participants (2)

2 Cheryl Thompson

o

)}

3y Make
[€Q) Make captioner

] Remove from session

O
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Make video and audio recordings for more personalized interactions:

Quick Notes

Teaching Development Pattis Notes Remembery DTLS Notes Blog +
8 Video
o
ﬁ}%)eo hs I\
Recording .
Video recording started: 6:46 PM Monday, November 23, 2020
9]
Audio
Recording
Audio recording started: 6:47 PM Monday, November 23, 2020
You can draw. Quickly
convert inked
History  Review View Help Class Notebook
words to text
T - 1 e & a
~A A AL Aaf NN L Fr G | &
[ ,_\_—/ ’_\’/ ’\_-/ ~_7 -‘ -‘ : Color & g%ig‘ﬁ Insert Arrange Inkto Inkto
/ : : e =11~ Thickness LY Space v Text  Math
Tools Shapes Edit Convert
$ Teaching Development Pattis Notes Remembery DTLS Notes Blog Quick Notes +

e qQ [K YOUL WK’fO)(
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Email OneNote Pages:

TP News Dec 2020.pdf
362 KB

R

NDUS/CTS

=
Work Well

DIY: Congestion-
Fighting Elixir

- Message (HTML)

Work Well TP News

“Joy is what happens to us when we allow ourselves
to recognize how good things really are.”
-- Marianne Williarmson

How to Stay Mentally
Healthy During the Holidays

Recognize that the people in your life

Create Tables by typing information.

Use the tab and enter keys to create columns and rows. The Layout contextual tab appears when a table is selected:

December 2020

File Message Insert Options Format Text Review Help  Grammarly Q Tell me what you want to do
Q] R | B avachFie~ F B i =
T & 8 ® .
Paste R Address Check i Assign Dictate Open Secure New
v - : Book Names BS'GNW'E v Policy ~ |, hd Grammarly Attach ~ Meeting Poll
Clipboard Is Basic Text Names Include Tags N Voice Sensitivity Grammarly | INDUS File Sharing Iy FindTime
}> To
Send Cc

G

View
Templates

Insights

My Templates ~

File Home Insert Draw  History

EEEE Y

Select Select Select Select Delete Delete
Table Columns Rows Cell Table Columns

Select Delete

[} Patti @ North Dakota Univers..

Meeting Minutes

Monday, November 23, 2020 9:30 PM

Date Agenda Item

Action Plan

Review View Help Class Notebook Layout

Delete Insert  Insert Insert Insert Hide Shading Align Center Align

Rows Above Below Left Right Borders  ~ Left Right
Insert Format Alignment

. v Teaching Development Pattis Notes Remembery DTLS Notes

21
Sort

v

Data

Blog

[
3
Convert to Excel
Spreadsheet

Convert

Quick Notes

7|Page

+



Attach files, spreadsheets, and Visio diagrams to a page:

Class Notebook

File Homell Insert Draw History Review iew Help

+ BB 1 & 8|ePR e 08008 B[ TQ|O

Link Record Record Date Time Date & Page

{
Insert Table File File Spreadsheet Diagram Screen Pictures Online Online
Space v Printout Attachment v - Clipping Pictures Video Audio Video Time Templates ¥ b
Insert Tables Files Images IMedia Links Recording Time Stamp Pages Symbols Stickers

Use the History tab to mark a page as read, locate recent edits, find an author, hide author information, examine

page versions, and open the recycle bin.

File Home Insert Draw History Review View Help Class Notebook

2B OKE O W

Mark as | Recent Find by Hide Page Notebook
Read v Edits ¥ Author Authors | Versions v Recycle Bin v

Unread Authors History

Use the Review tab for grammatical, accessibility and language assistance. Passwords can be applied to sections
within a notebook. Linked Notes let you dock OneNote to the side of your computer screen so you can look at
websites or other applications and take notes in OneNote. When you take notes this way, they're automatically
linked to whatever you're researching.

File Home Insert Draw  History Review View Help Class Notebook

> E [g | 5% A O w8

Spelling Research Thesaurus Check Translate Language | Password Linked
Accessibility ¥ h Motes
Accessibility Language Section MNotes

Spelling

The View menu lets you hide many areas of OneNote to work more efficiently. You can add page color, rule lines,
and you can hide the page title. There are new window and zoom control options as well as docking options.

File Home Insert Draw  History Review View Help Class Notebook

€ O | & ﬁﬁ_e\ LB o BT [ I

100%
Normal|Full Page Dock to Page Rule Hide Paper Zoom Zoom E ) New MNew Docked New Quick Always
Color v Lines v Page Title | Size Out In «- Page Width Window Window MNote  on Top

View View Desktop
Page Setup Zoom Window

Views

In the Help menu you can find training options:

File Home Insert Draw History Review View Help Class Notebook

® K] O &

Help Contact Feedback Show
Support Training

Help
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Copy and paste information from the web and a link to the website is included:

L} Patti @ North Dakota Univers.. - (S Dot (NG (Reverieyl o Notes | _sls

Mindfulness
Monday, November 23, 2020 9:30 PM

What is mindfulness?

Mindfulness is the basic human ability to be fully present, aware of where we are and what we're doing, and
not overly reactive or overwhelmed by what’s going on around us.

While mindfulness is something we all naturally possess, it's more readily available to us when we practice on
a daily basis.

Whenever you bring awareness to what you're directly experiencing via your senses, or to your state of mind
via your thoughts and emotions, you're being mindful. And there's growing research showing that when you
train your brain to be mindful, you're actually remodeling the physical structure of your brain.

From <https://www.mindful.org/meditation/mindfulness-getting-started/>

To turn this option off, choose:

File

Options

Advanced

Uncheck “Include link to source when pasting from the Web”

e
|

|

= OneNote Options

limlradd Blakars

General Advanced options for working with OneNote.
Display

Proofing Editing

Sync [] Show Paste Options button when content is pasted

Save & Backup ‘ Include link to source when pasting from the Wehb

Send to OneNote Apply numbering to lists automatically

Apply bullets to lists automaticall
Audio & Video | Apply b y

Calculate mathematical expressions automatically 0]
Language

Enable link creation by typing [[ 1] around a phrase
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Add hyperlinks to other areas within the notebook:

New Hire i Procedural Pedi ical VN Vendor Info Notes +

Add a link to a Stream video channel (users must have access):

5

Welcome to Our Team!
Monday, November 23, 2020 9:50 PM

We're glad you jeined our Team! This OneNote notebook is designed to help you get up to speed more quickly.
Here is your checklist. Be sure to mark off each section after you've finished reading it. Feel free to call on any one
of us at any time!

Directory ltem Notes or Questions
Locations and Staff Directory

Software for Home Use

Leadership - Snapshot

EMERGENCY PROCEDURES

HOW TO

CTS Employee Benefit: Microsoft for Home Use

Staff Directory

Semester Codes

Ooooooooooo

Tickets Desktop Support Team Dynamix

Feel free to contact us with your questions or just to visit!

1 &

Use Ctrl+K to insert a

PHONE SYSTEM hyperllnk or rlght CliCk
L R R for additional choices

Search (Ctri+E) 0
-I— Add Page

Welcome to Our Team!
Locations and Staff Directory
Software for Home Use
Leadership - Snapshot
EMERGENCY PROCEDURES
MultiBand Tower Evacuation
Parking & Fleet Vehicles - Far
PHONE SYSTEM
Phone Numbers User Services
Voicemail instructions
Phone Instructions
EC500 Phone Tips
Conference Rooms
RESQURCES - EMPLOYEE
Infobase Learning Cloud
Qualtrics
State Employee Training
Websites
Listservs and Email
HOW TO
Schedule IVN Meeting
Web Conferencing Options
Reserve Fleet Vehicles
Digital Signage
Installing Applications
CTS Employee Benefit Microsof

Using the Content Library +

Stream Video Channel
Monday, November 23, 2020 9:43 PM

Microsoft Stream

Blackboard Collaborate Videos

How to Use Blackboard Collaborate in Your Course...

Next >

2 videos | O followers ’
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Appendix A: Microsoft OneNote 2016 Common Keyboard Shortcuts

Source: https://support.microsoft.com/en-us/office/keyboard-shortcuts-in-onenote-44b8b3fs-c274-4bcc-a089-e8ofdcc87950 Visit this
link for a master list of keyboard shortcuts.

To do this Press
Open a new OneNote window. Ctrl+M
Create a Quick Note. Ctrl+Shift+M

Windows logo key+Alt+N

Dock the OneNote window. Ctrl+Alt+D

Undo the previous action. Ctrl+Z

Redo the previous action, if possible. Ctrl+Y

Select all items on the current page. Ctrl+A
To expand the selection, press
Ctrl+A again.

Cut the selected text or item. Ctrl+X

Copy the selected text or item to the Clipboard. Ctrl+C

Paste the contents of the Clipboard. Ctrl+V

Move to the beginning of the line. Home

Move to the end of the line. End

Move one word to the left. Ctrl+Left arrow key

Move one word to the right. Ctrl+Right arrow key

Delete one character to the left. Backspace

Delete one character to the right. Delete

Delete one word to the left. Ctrl+Backspace
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To do this Press

Delete one word to the right. Ctrl+Delete
Insert a line break without starting a new paragraph. Shift+Enter
Check spelling. F7

Open the thesaurus for the currently selected word. Shift+F7
Display the context menu for the currently focused object. Shift+F10

Perform the action suggested on the Information Bar when  Ctrl+Shift+W
it appears at the top of a page.

Play the selected audio recording. Ctrl+Alt+P
Stop audio recording playback. Ctrl+Alt+S
Skip the current audio recording backward by 10 seconds. Ctrl+Alt+Y
Skip the current audio recording forward by 10 seconds. Ctrl+Alt+U
Work with tables
To do this Press
Create a table. Tab key, after typing a new line of text
Create another column in a table with a single Tab key
row.
Create another row when at the end cell of a Enter
table.

Note: Press Enter again to finish the table.

Insert a row below the current row. Ctrl+Enter, when in a table cell
Create another paragraph in the same cell in a Alt+Enter
table.
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To do this Press

Create a column to the right of the current Ctrl+Alt+R
column in a table.

Create a column to the left of the current In OneNote 2010, Ctrl+Alt+E
column in a table.

Create a row above the current one in a table. Enter, when the cursor is at the beginning of any
row, except for the first row

Create a new cell. Tab key, when in the last cell of the table

Delete the current empty row in a table. Delete, then Delete again, when the cursor is at
the beginning of the row

Additional Resources

What’s new in OneNote for Windows 10

https://support.microsoft.com/en-us/office/what-s-new-in-onenote-for-windows-10-1477d5de-f4fd-4943-ba8a-
ff17091161€a

Microsoft 365 Blog — OneNote

https://www.microsoft.com/en-us/microsoft-365/blog/onenote/

What'’s the Difference Between OneNote Versions?

https://support.microsoft.com/en-us/office/what-s-the-difference-between-the-onenote-versions-a624e692-
b78b-4c09-bo7f-46181958118f

OneNote Class Notebook

https://www.onenote.com/classnotebook

Target areas for development (Microsoft Ignite conference November, 2019):
https://www.theverge.com/2019/11/7/20953691/microsoft-onenote-to-do-integration-fluid-framework-future-
features-ignite-2019

e Modern sync services to sync notebooks faster

@mentions for OneNote inside of Microsoft Teams

Microsoft Search integration to find the information in your notes
New meeting notes features

Tasks and To Do integration

Accessibility improvements

e Next-generation canvas
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